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ABSTRACT

Daily weather data commonly used in simulation models of agricul-
tural or ecological systems are sometimes incomplete, frequently con-
tain errors, and are often in an inconvenient format. The WeatherMan
is a user-oriented software package designed to assist in preparing daily
weather data for use with simulation models. The software can import
or export daily weather files with any column format (including the De-
cision Support System for Agrotechnology Transfer ver. 2.1 and ver.
3.0 files) and convert the data to desirable units. Data are checked and
flagged for possible errors on import. Several techniques are available
for filling in missing values and erroneous data on export. WeatherMan
also contains two methods (WGEN and sIMMETEO) for stochastically gen-
erating sequences of daily weather data. Both methods can be param-
eterized from the daily data and the second method uses monthly means
from any secondary data source. Summary statistics of raw and gen-
erated data can be graphed or presented in tables.

DAILY WEATHER DATA are commonly needed for input
to simulation models used in agricultural or ecologi-
cal systems. While the models require complete and re-
liable values in a particular format, the raw data from a
weather station, or even a reliable secondary supplier of
weather data, seldom meet these requirements. Common
data problems include: data format errors resulting from
alphabetic characters, missing data, data suspected to be
erroneous, and data in an inconvenient format. Sometimes
there are no data available for a specific site, and com-
monly not all the desired variables are in the available
weather record. Data errors usually result from sensor
and/or datalogger failure or sensor calibration drift.
The development of crop models and decision tools such
as the DSSAT (Decision Support System for Agrotech-
nology Transfer) to aid research and development in agri-
culture has been the focus of the IBSNAT (International
Benchmark Site Network for Agrotechnology Transfer)
project (IBSNAT, 1989). Available and reliable weather
data are essential to make reasonably good predictions
of crop growth and production using these models. The
IBSNAT project has defined a minimum daily weather
data set and format for use with the crop models. In the
minimum data set defined for IBSNAT ver. 2.1 (IBSNAT,
1989), the daily variables are solar radiation (MJ m™2
d™"), maximum temperature (°C), minimum temperature
(°C), rainfall (mm), and photosynthetically active radi-
ation (PAR, mol m~2 d') (if available). The IBSNAT
ver. 3.0 data set (Jones et al., 1993) has a different format,
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but uses the same variables, as well as dew point (°C)
and wind speed (m s™') if available. An example of the
file formats is given in Table 1.

The goal of the WeatherMan software is to provide the
necessary tools to archive, summarize, and manipulate
weather data into any convenient format. Previous efforts
to create weather databases (AWDN/AGNET, CIRIS,
DSSAT ver. 2.1) used relational databases to manage fixed-
format weather data usually collected by a state network
of automated weather stations (Hubbard et al., 1983; Snyder
et al., 1985; Carlson and Russell, 1988; IBSNAT, 1989;
Reinke and Taylor, 1991). Desired daily data or summa-
ries were exported to ASCII files. Other efforts (AZMET)
provide current 2-wk weather data summaries and evapo-
transpiration estimates on a computer bulletin board (Brown
and Yitayew, 1988). Only Robbins (1993) has developed
generic routines to read self-describing, random-access,
weather-data files in any format. There is currently no
system to easily read and write weather data files in any
format, provide techniques for replacing erroneous data
or generating data, and provide summary graphs and tables.

PROGRAM DESCRIPTION

The WeatherMan (short for weather data manager) pro-
gram is designed to simplify or automate many of the re-
petitive tasks associated with preparing raw weather data
for use by a crop model (or any other model) and can
also be used to provide quantitative analysis of weather
data. WeatherMan specifically handles the IBSNAT ver.
3.0 variables, but other daily weather variables can also
be added. It can be used either as a stand-alone package
or from within DSSAT ver. 3.0. WeatherMan has the abil-
ity to translate both the format and units of weather data
files, check for errors on import, and fill in missing or
suspicious values on export. WeatherMan can also gen-
erate complete sets of weather data comprising solar ra-
diation, maximum and minimum temperature, rainfall,
and photosynthetically active radiation. Summary statis-
tics of raw, filled, or generated data can be computed and
displayed in tables or graphs.

Specifications

WeatherMan is written in Turbo Pascal ver. 7 (Borland,
1993) and uses royalty-free graphics routines (Quinn-Curtis,
1993). The object-oriented utilities in Turbo Pascal’s Turbo
Vision were used to create a text-mode user interface for
‘WeatherMan that includes: pull-down menus; dialog boxes
with push buttons, radio buttons, check boxes, input lines,
scrolling dynamic lists, and context-sensitive help. The
WeatherMan interface functions both with the mouse and
the keyboard.

WeatherMan will work on an IBM-compatible micro-

Abbreviations: DSSAT, Decision Support System for Agrotechnology Trans-
fer; IBSNAT, International Benchmark Sites Network for Agrotechnology
Transfer; K, kilobyte; PAR, photosynthetically active radiation; ver., version.
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Table 1. Examples of weather data files using the IBSNAT formats.

Version 2.1

0 1 2 3 4 5
Line 0123456789012345678901234567890123456789012345678%012345

1 UFGA 29,63 82.37 11.50 1.00 XLAT, XLONG, PARFAC, PARDATt
2

3 SITE YR DOY SRAD TMAX TMIN RAIN PAR#

4 UFGA 88 1 9.31 23.3 10.3 0.0 18.62

5 UFGA 88 2 11.09 19.0 16.9 5.2 21.27

6 UFGA 88 3 3.13 23.9 15.6 0.0 11.65

Version 3.0

0 1 2 3 4 5
Line 01234567890123456789012345678901234567890123455789012345

«WEATHER : GAINESVILLE, FLORIDA, U.S.A.

@ INSI LAT LONG ELEV TAV AMP REFHT WNDHTt
UFGA 29.630 -82.370 10 20.9 7.4 1.5 2.0

@YRDAY SRAD TMAX TMIN RAIN DEWF WIND PAR¥
88001 9.3 23.3 10.3 0.0 11.3 165.0 18.6
0 88002 11.1 19.0 16.8 5.2 15.2 53.2 21.3
1 88003 3.1 23.9 15.6 0.0 14.5 201.4 11.7

W AU R W

+ Header abbreviations: AMP = average annual temperature range (°C); DOY
= 3-digit day of year; ELEV = weather station elevation (m); LAT = XLAT
= weather station latitude (°); LONG = XLONG = weather station longi-
tude (°); PARDAT = 0-1 flag to indicate presence of PAR data in file; PARFAC
— conversion factor from SRAD to PAR (langley/mol); REFHT = refer-
ence height for meteorological instruments (m); SITE = INSI = 4-letter
institution and site code; TAV = average annual temperature (°C); WNDHT
= reference height for anemometer (m); YR = 2-digit year; YRDAY = 5-digit
year and day of year.

+ Variable abbreviations: DEWP = daily dew point temperature (°C) (optional);
PAR = daily photosynthetically active radiation (mol m~2 d~') (optional);
RAIN = daily rainfall (mm); SRAD = daily solar radiation MIm2d;
TMAX = maximum daily temperature (°C); TMIN = minimum daily tem-
perature (°C); WIND = daily wind run (km d-1!) (optional).

computer with DOS ver. 3.1 or later and requires at least
280K of available conventional memory when working
with five weather variables. An extra 12K of memory are
required for each additional variable. WeatherMan works
best using a math coprocessor and at least 300K of avail-
able expanded memory since it performs faster and re-
quires 50K less available conventional memory. A hard
disk is recommended. Stored weather data files occupy
~ 14K per year for five variables. Standard video drivers
are automatically detected, and WeatherMan includes sev-
eral printer drivers for graphical output (Epson MX, Ep-
son FX, Toshiba, HP LaserJet, and HP InkJet), as well
as plotter and file output drivers (HPGL and Postscript).

Overview of Functions

The WeatherMan’s main menu items are: File, Station,
Import/Export, Generate, Analyze, Options, Quit. The
File menu accesses a user-selectable text editor for data
entry and correction, accesses the operating system (DOS),
and allows the current weather data directory to be changed.
A new weather station is selected from the Station menu.
The Import/Export menu handles the conversion of file
formats and units when importing and exporting weather
data into or from a storage data file. Many file formats
can be accommodated, including the standard IBSNAT
ver. 2.1 and 30 files. WeatherMan checks for and flags
format or range errors on import. On export, data flagged
as missing or erroneous can be replaced or approximated
using several methods. The Generate menu permits gen-
eration of synthetic sequences of solar radiation, maxi-
mum and minimum temperature, rainfall, and photosyn-
thetically active radiation for any duration. The Analyze

menu includes the computation of summary statistics and
the ability to display the results using tables or graphs.
The Options menu allows the user to customize the de-
fault setup. The user can leave the program using the Quit
menu or the File-Exit submenu.

File Operations

File operations are grouped under the File menu, which
gives access to an editor, DOS functions, and additional
help. The Edit menu item accesses a text editor so that
data files can be viewed and edited. Under DSSAT ver.
3, the default DSSAT editor is used. If WeatherMan is
used as a stand-alone program, a modified Turbo Pascal
editor called TVEDIT2 can be provided as the default editor
(Borland, 1993). The user can use any editor by changing
the default path and editor name under the Options menu.
The Change Dir menu item will change to another data
directory to access other weather data and archived files.
The Dos Shell menu item allows one to leave the Weath-
erMan program temporarily without removing it from mem-
ory, which is useful for performing DOS functions like
renaming, deleting or copying files. The About menu item
displays introductory information on the WeatherMan. Ad-
ditional information about the program can be accessed
by pressing F1 from the introductory dialog box. The Exit
menu item is used to permanently exit the WeatherMan
program.

Selecting a Weather Station

The Station menu allows selection of a weather station
and the entry of general station information. On identi-
fying a station, archive and climate files are automatically
created based on the station name (here represented in
italics as station). The archived file (station. wTD) is an
internal ASCII file that has a standard format and fixed
set of units that mirrors the imported raw data. Although
we could use random access files (as did Robbins, 1993),
prior user response with DSSAT ver. 2.1 database files
was very negative. We gave higher priority to user access
of the ASCII archived file than the increased speed that
results from random access.

Weather data are imported into and exported from the
archived file, and the file can also be used for long-term
storage of weather data. The climate file (station.CL1) con-
tains site information, weather generator parameters, range-
check values, and summary statistics for the station. It
is automatically updated after each Import operation and
is an alternative to self-describing files (Robbins, 1993).

Since most operations in WeatherMan require the se-
lection of a Weather station, this is normally the first menu
used. A station is selected from a list of all archived
(station.wTD) files in the current directory. Files in other
directories can be displayed by selecting the appropriate
directory under the File menu. When a new weather sta-
tion is selected, the user is automatically prompted for
general information regarding the new station. This infor-
mation can be subsequently edited. Of this information,
only latitude is absolutely essential, since it is used to ver-
ify the radiation data. For a new station, the user can choose
to manually enter the monthly means of solar radiation,
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maximum temperature, minimum temperature, rainfall to-
tal, and rainfall frequency. These data are usually avail-
able from published secondary sources of climate data
(NOAA, 1974, 1977; Samani and Hargreaves, 1989). Al-
ternatively, these values can be computed by the Weath-
erman using the available daily data in the archived file.
The user is warned if <5 yr of good quality daily data
are currently available. Monthly means are stored in the
climate file for the current station. The monthly means
are used by the WeatherMan for filling in data and gen-
erating weather data sequences. These options are disabled
when there are no available monthly means.

Importing and Exporting Data

The Import/Export menu performs all the necessary
data manipulation for inserting data into the archived file
(Import) and extracting it to create other files (Export).
Both the Import and Export menu items use a format
definition file (*.FMT) to translate the format and units
of the data between the specified input or output file and
the archived file. Currently only data in columns are per-
mitted. Processing of other format types (row, comma de-
limited) could easily be developed. The user can custom-
ize the column format for up to 12 variables (any order,
any units).

The simplest Import-Export function is to translate
a file from one format to another. This feature uses a tem-
porary archived file and sequentially imports then exports
with checking and data-fill options disabled. Other Im-
port or Export options use a permanently archived file
and refer to its corresponding climate file for the checking
and data-fill functions.

The Import menu item can be used to import a single
file or multiple files. The first is simpler; the second builds
a sorted list of files and formats that are sequentially im-
ported. The multiple-file feature is useful when the weather
variables are stored in different files with different for-
mats, or for a group of files with the same format. The
list of files can be constructed easily and rapidly, permit-
ting the user to import all the available weather data for
a weather station in a single operation.

Variables that have errors or are suspect are automat-
ically flagged on import. The error types, with their ex-
planation and code, are listed in Table 2. The error types
are based on a subset of those used by the National Cli-
matic Data Center (Reek et al., 1991). A value is flagged
if it is less than some minimum, greater than some max-
imum, or exceeds a specified rate-of-change from one day
to the next. When a variable is flagged during import, its
value remains unaltered. The extreme values used to check
each variable can be easily modified from an Import menu
item. The radiation extremes are seasonal, since they are
expressed in terms of percent of extraterrestrial radiation.
On import, a lowercase letter is used to flag each error.
On export, if the missing or erroneous value is replaced
or approximated, the flag is converted to uppercase to in-
dicate that the original value was modified.

Conversion errors normally result from an incorrect for-
mat or a nonnumeric character. This type of error results
in a missing value (—99.0). If specified by the user, a non-

Table 2. Explanation of error codes used to flag suspect or errone-
ous data, and examples of raw weather data, archived, and ex-
ported files including these codes. Errors are flagged with lower
case codes on import into the archived file. On export, if the flagged
data are filled, the flagged codes are converted to upper case. File
formats were adjusted for ease of comparison.

Import Filled

Class Description code export code
Range check Above maximum a A
Range check Below minimum b B
Range check Above rate of change r R
Conversion Missing value n N
Conversion Format error 3 E
Variablest
File SRAD TMAX TMIN RAIN PAR
Imported 62.23 23.3 -25.3 0.0 77.2?
11.09 8.3 16.9 21.30
3.10 23.9 15.6 TRACE 11.70
Archived 62.2a 233 -25.3b 0.0 —-99.0e
11.1 8.3r 16.9 -99.0n 21.3
3.1 239 15.6 0.0e 11.7
Exported 9.30A 23.3 10.3B 0.0 18.60E
11.10 19.0R 16.9 5.2N 21.30
3.10 23.9 15.6 0.0E 11.70

+ SRAD, daily solar radiation (MJ m~2 d~'); TMAX and TMIN, maximum
and minimum daily temperature (°C); RAIN, daily rainfall (nm); PAR,
daily photosynthetically active radiation (mol m—2 d-%).

numeric value can be translated into a numeric value: e.g.,
‘TRACE’ for rainfall can be converted into 0.00 mm rather
than a missing value. At the end of the import process,
a summary report is given indicating the quantity and qual-
ity of data in the archived file. The Import options in-
clude a default for the format name (e.g., IBSNAT), a
switch to enable/disable range-checking, and a choice to
prompt for the translation of nonnumeric characters in
the data.

The Export menu item can be used to export a single
file or yearly files. For the yearly file option, the names
of the export files are constructed automatically, using either
the IBSNAT ver. 2.1 or 3.0 naming convention. The files
can easily be renamed using the DOS RENAME command.
The export options include a default choice of format name
(e.g., IBSNAT), two file name conventions for yearly files
(IBSNAT ver. 2.1 or 3.0), choices for including header
information, and various options for data-fill and error
flag handling. Data-fill for missing data, range errors, and
missing dates can be enabled or disabled, and there is a
choice to export error flags. If the data-fill option is se-
lected, there are several choices for the method to be used.

There are two generic data-fill methods used for all
weather variables. The first generic method is to generate
all missing data with the WGEN or SIMMETEO weather gen-
erators. The second method uses the monthly means from
the climate file. The generators only fill in solar radiation,
maximum temperature, minimum temperature, rainfall,
and PAR. Data-fill using the monthly means applies to
all variables except rainfall, since a constant drizzle would
cause severe problems with any water balance. A simple
stochastic generator is used for rainfall. There are additional
data-fill methods for solar radiation and short periods of
missing data. Solar radiation can be estimated from sun-
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shine hours and extraterrestrial radiation (Doorenbos and
Pruitt, 1977), using coefficients that are entered as general
site information. Short periods (<7 d) can be filled using
a 10-d running mean, but for longer data gaps the generic
data-fill methods are automatically invoked.

An illustration of the codes is given in Table 2, showing
the use of these codes in the archived and exported files.
Prior to importing the original raw data file into the ar-
chived file, the file had two or three errors per line. On
importing into the archived file, the alphabetic errors were
changed, while the other erroneous data were only flagged.
The export file was created with all the data-fill options
enabled, thus the errors were filled and the error flags
were converted to uppercase codes.

Generating Weather Data

The Generate menu allows estimation of the weather
generation parameters and subsequent generation of daily
weather data. The weather generators used are adaptations
of WGEN (Richardson and Wright, 1984) and SIMMETEO
(Geng et al., 1986; Geng and Auburn, 1986; Geng et al.,
1988). The SIMMETEO generator is embodied in the WGEN
generator, but uses a different input section. The resulting
WGEN/SIMMETEO code is a single program that is identical
to the FORTRAN version currently used internally with
the IBSNAT ver. 3.0 crop models. Currently, only solar
radiation, maximum temperature, minimum temperature,
rainfall, and PAR are generated. Future versions could
include wind speed and vapor pressure.

The IBSNAT ver. 3.0 modification of WGEN/SIMMETEO
now uses monthly input parameters for all variables. Dai-
ly values are computed internally, using linear interpolation.
The modified SIMMETEO model uses monthly climate means
and regression equations (Geng et al., 1986; Geng and
Auburn, 1986; Pickering et al., 1988) to compute the stan-
dard deviations. We found that using standard deviations
is more reliable than using coefficients of variations to es-
timate the monthly standard deviations. A seasonally in-
creasing mean and decreasing coefficient of variation can
produce an odd seasonal effect on standard deviation. It
is also easy to prevent impossible (negative) predicted stan-
dard deviations.

The parameters for WGEN or SIMMETEO can be computed
separately or together, using all the data or a particular
time period in the archived file. The computed monthly
parameters are recorded in the climate file. Estimating
the SIMMETEO parameters is equivalent to calculating the
monthly means from the Station menu. If the monthly
means in the climate file are from a longer and more re-
liable record than the daily data, the user should not es-
timate SIMMETEO’s parameters using the daily data, since
the long-term means will be overwritten. Estimating gen-
erator parameters is a reasonable option if there are suffi-
cient reliable data in the archived file or if there are no
available climate data. The user is warned if there are <5
yr of reliable data in the archived daily data file.

The generated data are output to a generated archived
file (station_GENwWTD). The default action is to use the
time period of the archived file for the generated data,
although any time period can be specified. Matching the

time periods facilitates comparison of observed and gen-
erated data. A random number seed is reset from the sys-
tem clock each time the generator is used, but any random
number can be specified by the user. Often the same num-
ber is desired to create repeatable sequences of generated
weather data.

Analyzing Weather Data

The Analyze menu calculates and presents summary
statistics for archived weather data in the form of tables
and graphs. The analysis can be performed on raw, filled,
or generated data. Analyze also offers range-check and
data-fill functions similar to those normally done auto-
matically on import or export. The range-checking pro-
cess is useful when the file import was done with incor-
rect range check values or when the range checking option
was turned off. Re-checking is also useful in defining rea-
sonable range-check values for a weather station by iter-
atively setting the range-check values and appraising how
many values are flagged. The data-fill option creates a filled
archived file (station_riLwTD) that can be analyzed and
compared with the raw data to check the data-fill algorithms.

The statistics option provides algorithms for summariz-
ing archived data in various ways. Statistics are output
to summary files that can be viewed, printed, or graphed.
There are four types of statistics: moments, percentiles,
distribution, and time structure. The moments include the
means, standard deviations, and skewness coefficients.
The percentiles are the 0, 25, 50, 75, and 100% quantiles.
The distribution statistics option includes both histograms
and cumulative probabilities. The time structure option
includes autocorrelograms for all variables except rainfall
and conditional probabilities for rainfall. All statistics,
except autocorrelograms and rainfall conditional probabil-
ities, are automatically computed for wet, dry and both
days. The autocorrelograms and rainfall conditional prob-
abilities use the complete time series thus do not distin-
guish between wet and dry days. Three statistics groupings
can be selected: monthly summary, monthly time series,
and yearly time series. An overall summary (normals) is
automatically performed with the monthly summary.

The graphics capabilities include plotting both the daily
data in the archived files and the statistics summary files.
Time-series graphs, box plots, histograms (for probability
distributions and conditional rainfall probabilities), cu-
mulative probability distribution plots, and autocorrelo-
grams are available. The time-series graphs can be used
to plot either daily data or summary statistics versus time.
There is considerable flexibility in choosing the weather
station, grouping, variables, and wet state (i.e., wet days,
dry days, or all days), and the time period of data to be
plotted. Up to six plots per graph can be defined and plotted.

Two examples of WeatherMan graphs are given in Fig.
1 and 2. Figure 1 is a simple illustration of a daily data
plot (in this case, maximum and minimum temperatures
versus time). This kind of plot is useful for visually screen-
ing data for obvious errors (e.g., data points that remain
constant). Figure 2 is an example of a plot of the moments
that are computed using the Statistics menu item. The
plot compares the mean monthly maximum and minimum
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DAILY DATA FOR UFGA (1978)
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Fig. 1. Plot of 1978 daily maximum and minimum temperature (°C)
versus time (d) for Gainesville, FL (UFGA). Multipliers for the y-
axis are given in parentheses in the legends. Enhanced for publication.

SUMMARY DATA FOR UFGA
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Fig. 2. Plot of overall mean monthly maximum and minimum temper-
ature (°C) versus time (months), using raw and generated data for
Gainesville, FL. (UFGA). Enhanced for publication.

temperatures from raw and generated files. This feature
can be used to visually verify and validate the generation
and data-fill algorithms.

Selecting Options

The Options menu allows the user to customize the
default setup. The display mode is automatically detected,
but can be changed if another valid choice is desired. The
video mode is best left in autodetect mode unless the pro-
gram has difficulty selecting the correct mode and a man-
ual choice gives better screen appearance. Liquid crystal
displays (L.CDs) or plasma displays used on portable com-
puters sometimes look better in black and white mode
than in the automatically detected color mode. Background
and foreground colors used in the WeatherMan can also
be changed. Directories for the daily weather data, cli-
mate files, graphics program, graphics output, and file

editor can be changed. These directories can also be ob-
tained from the DSSAT profile file, which is available if
the program is being run under DSSAT ver. 3.0. Sum-
mary, generated, and filled archived files are temporary
files that are normally discarded on terminating Weath-
erMan. This default action can be modified to automat-
ically keep all temporary files or to prompt the user to
keep or discard each file. The graphics program can be
customized by changing the format (e.g., grid, ticks), col-
ors, and output drivers as mentioned in the above Specifi-
cations section. The changes in the Options menu can
be permanently updated if desired. Updating options also
saves the current options chosen in the Import, Export,
Data-Fill, and Summary Statistics menus.

AVAILABILITY AND DOCUMENTATION

The WeatherMan program can be obtained from the
IBSNAT project headquarters or from the development
group at the following addresses: Dr. Gordon Tsjui, IBS-
NAT Project, University of Hawaii, 25000 Dole St., 22
Krauss Hall, Honolulu, Hawaii 96822; Dr. James W. Jones,
Department of Agricultural Engineering, University of Flor-
ida, Gainesville, FL. 32611. Interested persons should send
a letter of request and a single 3.5- or 5.25-inch high-
density diskette. Included with the program is the Weath-
erMan manual, which describes its features and the in-
stallation procedure, and gives detailed information on
each function.
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The ALFALFA CATALOG Software Package
M. S. Townsend, J. A. Henning,* and C. G. Currier

ABSTRACT

Due to modern plant breeding methods, agricultural producers have
many cultivars available for many different species. Consequently, it
is often difficult to recommend a cultivar for a particular growing area.
A list of alfalfa cultivars, germplasms, and breeding lines available was
published. However, due to the large number of entries in these pub-
lications finding pertinent information about a cultivar, breeding line,
or germplasm was tedious. The objectives of this project were to (i) de-
velop a computer program to access the alfaifa information in the orig-
inal database, and (ii) update the database to include those alfalfa cul-
tivars, breeding lines, and germplasms released through late 1992. A
computer program was written using Microsoft QuickBasic, ver. 4.5.
The original alfalfa database was converted to ASCTI format. The re-
sulting software package is entitled the ALFALFA CATALOG ver. 1.0.
Three program files and four data files comprise the ALFALFA CAT-
ALOG software package. Users may rapidly search the database and
retrieve entries by cultivar name, experimental designation, or germ-
plasm. We also wrote a routine to print a list of all cultivars or germplasms
that have a specific combination of traits. These search capabilities will
allow plant breeders, extension agents, and consultants rapid access to
pertinent alfalfa data. Currently, the ALFALFA CATALOG has 752 en-
tries for cultivars and breeding lines, and 144 entries for germplasms.
The database will be updated yearly. In its present form, the ALFALFA
CATALOG is probably the most complete compilation of alfalfa culti-
vars, breeding lines, and germplasms available.

THE IMPLEMENTATION of superior plant breeding tech-
niques has allowed plant breeders to rapidly develop
improved plant populations for crop production. An un-
fortunate consequence of numerous cultivars is the difficulty
encountered when one must identify suitable cultivars for
different productio:, areas. Agricultural scientists, exten-
sion personnel, and consultants often recommend culti-
vars for specific growing areas. Much time is spent re-
viewing research reports and analyzing data to make such
recommendations. Plant breeders may need to obtain popu-
lation characteristics for cultivars, breeding lines, or germ-
plasms suited to a particular geographic region. This can
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be a time-consuming task given the amount of plant ge-
netic resources available.

Hannaway et al. (1992) released a computerized data-
base called ACE, which allows producers and consultants
to find alfalfa (Medicago sativa L.) cultivars based on search
criteria. This computerized database contains =450 al-
falfa cultivars, and information related to seed certifica-
tion, cultural practices, diseases, and other production top-
ics. Although a very useful program, ACE is somewhat
limited in that it does not contain all cultivars that have
been released, nor does it contain alfalfa breeding lines
and germplasms that are available. Also, ACE appears
to be oriented to assist consultants and extension person-
nel with alfalfa varietal selection.

New Mexico State University compiled all of the pub-
lished alfalfa cultivars, breeding lines, and germplasms
released prior to 1983 (Miller and Melton, 1983). This
compilation and the 1989 update (Melton et al., 1989)
provided valuable information to anyone interested in al-
falfa genetic resources. Information on 640 cultivars and
breeding lines, and 144 germplasms were included in these
publications. Because of the large size of these databases,
retrieving information was time-consuming.

A solution to enhancing the availability of alfalfa infor-
mation in the New Mexico publications was to develop
a computerized database. The objectives of this project
were to (i) write a computer program to access the infor-
mation in the New Mexico publications and (ii) update
the databases to include alfalfa cultivars, breeding lines,
and germplasms released through late 1992.

PROGRAM DESCRIPTION

Information for the databases was obtained from North
American Alfalfa Improvement Conference reports, Crop
Science registrations, and summaries from applications
to the National Alfalfa Variety Review Board. The orig-
inal databases were entered onto computer using PC-
FILE+ (ver. 2.0, 1988; ButtonWare, Bellevue, WA). The
databases were converted to ASCII format for use with
the ALFALFA CATALOG software package. There are

Abbreviations: K, kilobyte; ver., version.



